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முன்னுரை:-  

COA கம்ப்யூட்டர ் பயிற்சி கற்றுக்ககொள்ள இந்த புத்தகத்தத 
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நிசச்யம் நிதறதவறும். இன்தறய வொழ்நொளில் கணினி பயிற்சி ஆனது மிக 
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உங்களொல் ஒரு சிறந்த அலுவலக தமலொண்தமதய கணினியின் மூலம் 

நிறுவகிக்க முடியும் என்பதில் ஐயமில்தல. 
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Practical-லில் குதறந்தபடச்ம் 50 மதிப்கபண்களும் எடுத்தொல் நீங்கள் 

கவற்றி கபற்றதொக கருதப்படும்.  

Practical ததரவ்ின்தபொது 34 கசய்முதற விளக்க Record Note -ஐ நீங்கள் 

சமரப்்பிக்க தவண்டும். அதிலிருந்து 3 கசய்முதறகள் உங்களுக்கு Practical 

வினொவொக வரும். இதற்கு தததவயொன Practical Note & Practical Guide நொங்கள் 

எளிதமயொக புரியும்வண்ணம் Video கதொகுப்புகளுடன் வழங்க உள்தளொம். 

இப்பயிற்சி புத்தகம் ஆங்கில வழியில் இருந்தொலும் எளிதமயொக 

புரியும் வண்ணம் வடிவதமக்கப்படட்ுள்ளது. COA ததரவ்ில் (Theory & Practical) 

குறுகிய கொலத்தில் கவற்றி கபற வீடிதயொக்கள் (தமிழில்) இதனுடன் 

இதணக்கப்படட்ுள்ளது. கீழ்க்கண்ட இதணய தளத்தின் மூலம் பொடம் 

கதொடரப்ொன சந்ததகங்கதள தீரத்்துக்ககொள்ள முடியும். 

Model Practical Exam Question Paper உள்ளது. உங்கள் கம்ப்யூட்டர ்அறிவு 

திறதன வளரத்்துக் ககொள்ள Google Playstore -ல் கசன்று COA Quiz App ஐ 

Download கசய்து குதறந்தபடச்ம் 18 level -ஐ பூரத்்தி கசய்யவும். 
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OPERATING SYSTEM 
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between windows Running a program from 
explorer 

9  

2  
Customizing the Task bar, Making the taskbar 
wider Controlling the size of start menu options 
Adding a program to the start menu 

14  
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Recycle bin, restoring the deleted files Arranging 
icons on the Desktop 
Creating Shortcuts. Adding a program shortcut in 
the Desktop  

20  

4  
Creating and removing folders, renaming folders 
and files Expanding and collapsing a folder 
Sorting a folder  

25  

5  
Displaying the properties for a file or folder Using 
cut and paste operations to move a file Using 
copy and paste operations to copy a file  

31  
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Searching a file or folder by using search 
command Recognizing File types using icons 
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viz. totaling the column. 
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prepare index for a document.  

75  
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MS OFFICE: MS-EXCEL & OPEN OFFICE: CALC & MATH 
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Using formulas and functions: 
To prepare a Worksheet showing the monthly 
sales of a company in different branch offices 
(Showing Total Sales, Average Sales). 
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students in 5 subjects (using formula to get 
Distinction, I Class, II Class and Fail under Result 
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Using the data consolidate command: 
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100  
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Sorting Data, Filtering Data and creation of Pivot 
tables. 

102  
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Creating Student’s address Database and then list 
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111  

https://cceindia.in/


COA – Computer on Office Automation - Practical Book 6 
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Ex No: 1 Date:  

a) Starting a program, running a program 

b) Running multiple programs and switching between windows 

c) Running a program from explorer 

 
AIM : Starting a program, running a program 

Procedure: 

Option 1: 

Step 1:  Click the Start button or press the Windows key on your keyboard 

Step 2: Type the name of the program you want to run in the search bar and press Enter. 

 

 

Step 3: Click on the program's icon to launch it. 

Option 2: 

Step 1: Press "Start" + R on your keyboard in Windows to open the "Run" dialog. 
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Step 2: Type the name of the program (“Calc”) you want to run in the Text box and press 
Enter or OK.  

Step 3: Once the program has launched, you can use it as normal. 

Result:  

The program was executed successfully and the output has been verified. 

Output:   
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AIM : Running multiple programs and switching between windows    

Procedure: 

Step 1: When you press the "Start" + R on your Windows keyboard, it opens the "Run" dialog 
box. 

 

Step 2: Type the name of the program ("Calc") you want to run in the text box and press Enter 
or OK.  

Step 3: To run another program, repeat Step 1 (press the "Start" + R), then type the name of 
the program ("mspaint") you want to run in the text box and press Enter or OK. 

 

Switch Between Open Programs:  

Once the programs are open, they will appear as separate windows on your desktop. 

Step 4: Press the Alt + Tab keys simultaneously to switch between open applications.  

Step 5: Press and hold Alt, then tap Tab once to reveal all opened programs in a small box.  

Step 6: While holding Alt, release the Tab key but continue pressing Alt, then press Tab again 
until you reach the desired program.  

Step 7: Each time you press Tab, you cycle through the icons representing open programs.  

Step 8: Release the Alt key. Windows 10 will switch to the selected program.  

Step 9: To switch back to the last active program, simply press Alt + Tab again. The last active 
program will become active once more. Alternatively, you can use the Windows Key 
+ Tab.. 
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Result :  

The program was executed successfully and the output has been verified. 

Output:   
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AIM : Running a program from explorer 

Procedure: 

Step 1: Press the keys Start + R to open the Run window.  

Step 2: In the box, type "explorer" and click OK.  

 

Option 2: 

Step 1: Press the Start key or Start button and then press E to open My Computer - the File 

Explorer will open.  

Result:  

The program was executed successfully and the output has been verified. 

Output:   
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Ex No: 2 Date: 

a) Customizing the Task bar, Making the taskbar wider 

b) Controlling the size of start menu options 

c) Adding a program to the start menu 

 

AIM : Customizing the Task bar, Making the taskbar wider 

Procedure: 

Step 1: The taskbar settings by right-clicking an empty area of the taskbar and then clicking 
on "Taskbar Settings”. 

 

 
Change Customizing the Task bar 
 

Step 2: Lock the taskbar  OFF / ON 

Step 3: Automatically hide the taskbar in desktop mode OFF / ON 

Step 4: Use small taskbar buttons  OFF / ON 

Step 5: Place your mouse at the top edge of the taskbar and drag to resize it. 

Making the taskbar wider 
  
Step 6: Click and hold the left mouse button while dragging the cursor towards the left or right 

side of the screen to make the taskbar wider 
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Result:  

The program was executed successfully and the output has been verified. 

Output:    

"Changing the size and location of the taskbar to the right side." 
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Aim: Controlling the size of start menu options 

Procedure: 

To control the size of the items in the Start menu, you can use the following steps: 

Step 1: Right-click on an empty space on the taskbar and select "Taskbar settings" from the 
context menu. 

 

Step 2: Scroll down to the "Start" section and click on the "Customize your Start menu" 
and then turn on Use Start full screen. 

 

Step 3: Show app list in Start menu ON/ OFF 

Step 4: Show recently added apps ON/ OFF 

Step 5: Show most used apps ON/ OFF 

Step 6: Show suggestions occasionally in Start ON/ OFF 

Step 7: Use Start full screen ON/ OFF 

Step 8: Show recently opened items in Jump Lists on Start or the taskbar and File Explorer 

Quick Access ON/ OFF 

https://cceindia.in/
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Result:  

The program was executed successfully and the output has been verified. 

Output:  

Enable the Start Menu in full-screen mode. 
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AIM : Adding a program to the start menu 

Procedure: 

To add a program to the Start menu in Windows, you can use the following steps: 

Step 1: Right-click any shortcut icon on the desktop. 

 

Step 2: From the pop-up menu, select "Pin to Start."  

Step 3: Click the Start button. 

Step 4: You will now see the shortcut icon added to the Start menu. 

Step 5: To remove the icon from the Start menu, right-click the shortcut icon on the Start 
menu. 

Step 6: From the pop-up menu, select "Unpin from Start." 

Result:  

The program was executed successfully and the output has been verified. 
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Output:  
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Ex No: 3 Date:  

a) Recycle bin, restoring the deleted files 

b) Arranging icons on the Desktop 

c) Creating Shortcuts. Adding a program shortcut in the Desktop 

 
AIM: Recycle bin, restoring the deleted files 

Procedure: 

To restore deleted files from the Recycle Bin in Windows, you can use the following steps: 

Deleted files or folders. 

Step 1: Select the files or folders you want to delete.  

Step 2: Press the Delete key and click Yes.  

Step 3: The files or folders will be moved to the Recycle Bin.  

Step 4: If you need to permanently delete them, press Shift + Delete keys and click Yes. 

Note : once the files or folders are recovered, it's not possible to reverse 
the process. 

Restoring files or folders.  

To restore deleted files from the Recycle Bin in Windows, you can use 
the following steps: 

Step 1 : Open the Recycle Bin by double-clicking on its icon on the desktop or by pressing 
the Windows key + E and then selecting the Recycle Bin folder. 

Step 2: Locate the items that you want to recover. 

Step 3: Check the box next to the files or folders you want to retrieve. 

Step 4: Right-click and select restore to recover the items to their original locations. 

Step 5: Select restore all items to restore everything in your recycle bin. 

Result:  

The program was executed successfully and the output has been verified. 
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Output:  

 

Empty Recycle Bin – All files and folders will be permanently removed from their source location. 

 

Delete – All files and folders will be permanently deleted. 
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AIM : Arranging icons on the Desktop 

Procedure: 

Auto Arrange Icons 

Step 1: Click the Start button or press Windows key + D to navigate to the Windows desktop. 

Step 2: Right-click on a blank area of the desktop, then select "View." 

Step 3: Choose "Auto arrange icons." 

 

Sort by Arrange Icons 

Step 4: Right-click on a blank area of the desktop, then select "Sort by."  

Step 5: Choose to arrange icons by Name, Type, Size, or Date modified, and then click 
"Arrange Icons."  

Step 6: If you don't want icons to auto-arrange, click "Auto Arrange" to remove the 
checkmark. 

 

Result:  

The program was executed successfully and the output has been verified. 
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Output:  

Right-click a blank area on the desktop. Select "Sort by" to arrange icons by Name, Type, Size, or 

Date modified. Click "Arrange Icons." 
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AIM : Creating Shortcuts. Adding a program shortcut in the Desktop 

Procedure: 

Step 1: Click the Start button.  

Step 2: Browse to the Office program for which you want to create a desktop shortcut.  

Step 3: Left-click the name of the program and drag it onto your desktop.  

Step 4: A shortcut for the program will appear on your desktop.  

Step 5: Right-click the program name, file, or folder, then click "Send To" and select "Desktop 
(Create shortcut)."  

Step 6: A shortcut for the program will appear on your desktop. 

Result:  

The program was executed successfully and the output has been verified. 

Output:  
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Ex No: 4 Date:  

a) Creating and removing folders, renaming folders and files 

b) Expanding and collapsing a folder 

c) Sorting a folder 

 

AIM : Creating and removing folders, renaming folders and files 

Procedure: 

Creating New Folder  

Step 1: The fastest way to create a new folder in Windows is by using the Ctrl+Shift+N 
shortcut.  

Step 2: Right-click on a blank space in the desired folder location.  

Step 3: From the contextual menu, select "New" and then choose "Folder" Windows will 
create the new folder at your current location. 

 

Step 4: To rename a newly created folder, enter the desired name and press Enter. 

Alternatively, you can use F2 Function key to rename a file or folder. 

Removing Files or folders 

Step 1: Select file the files or folders you want to delete  

Step 2: Press Delete Key and Click Yes.  

Step 3: The files or folders Move to Recycle Bin. 

Step 4: If need Permanent Deleted then Press Shift + Delete Key and Click Yes. 

Note: After recovery, it is not possible." 
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Renaming Folders and Files 

Step 1: Press the Start + E buttons.  

Step 2: Navigate to the location where your file or folder is stored.  

Step 3: Right-click on the name of the file or folder you wish to rename.  

 

Step 4: Click "Rename" from the opened menu.  

Step 5: Alternatively, to quickly rename, click on the file and press the F2 key.  

Step 6: Type a new name for the file or folder and press the Enter key. 

Result:   

The program was executed successfully and the output has been verified. 

Output:  

 

https://cceindia.in/


COA – Computer on Office Automation - Practical Book 26 

AIM : Expanding and collapsing a folder 

Procedure: 

Step 1: Press the Start + E Buttons.   

 

Step 2: Go to 'View' → 'Navigation Pane' → Click on 'Show all folders'." 

 

Step 3: Click the > (plus symbol) in the folder tree to expand a folder.  

Step 4: Alternatively, you can double-click a parent folder in either the left or right pane to 
expand it.  

Step 5: To collapse a folder, click the V (minus symbol) in the folder tree." 



h t t p s : / / c c e i n d i a . i n   27 

Result:  

The program was executed successfully and the output has been verified. 

Output: 

Expand One Level  

Expand Two Levels  

Expand Three Levels  

Expand All Levels  

Collapse All 

 

  

https://cceindia.in/


COA – Computer on Office Automation - Practical Book 28 

AIM : Sorting a folder 

Procedure: 

Step 1: Open File Explorer by pressing the Start button + E. 

Sort by Arrange folder 

Step 2: Right-click a blank area in the File Explorer window and select "Sort by."  

Step 3: Choose an option, such as Name, Date, Size, Type, Date modified & Dimensions.  

Step 4: The available options vary based on the selected folder type. 

Ascending: Select to sort items in ascending order (A-Z). 

Descending: Select to sort items in descending order (Z-A). 

 

Group by Arrange folder 
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Step 1: Right-click a blank area in the File Explorer, then select "Group by."  

Step 2: Choose an option, such as Name, Date, Size, Type, or Date modified. 

Result:  

The program was executed successfully and the output has been verified. 

Output:  
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Ex No: 5 Date:  

a) Displaying the properties for a file or folder 

b) Using cut and paste operations to move a file 

c) Using copy and paste operations to copy a file 

 
AIM : Displaying the properties for a file or folder 

Procedure: 

Step 1: Press the Start button + E key.  

Step 2: To view information about a file or folder, right-click it and select "Properties."  

Step 3: Alternatively, you can also select the file and press the Alt + Enter keys. 

Result:  

The program was executed successfully and the output has been verified. 

Output:  

 

The file properties window shows you information like the type of file, the size of the file, and when 

you last modified it. , Parent Folder, Free Space, Accessed. 
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AIM : Using cut and paste operations to move a file 

Procedure: 

Step 1: Press the Start button + E key.  

Step 2: To cut a file or folder, select it, then right-click and choose "Cut."  

 

Step 3: Alternatively, you can also select the file and press Ctrl + X. 

Step 4: Right-click a blank area in the File Explorer, then select "Paste."  

 

Step 5: Alternatively, you can also select the file and press Ctrl + V. 

Result:  

The program was executed successfully and the output has been verified. 

Output: 

 

Ctrl +  X  (Cut)  →  Ctrl + V  (Paste)  
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AIM : Using copy and paste operations to copy a file 

Procedure: 

Step 1: Press the Start button + E key.  

Step 2: To copy a file or folder, select it, then right-click and choose "Copy."  

 

Step 3: Alternatively, you can also select the file and press Ctrl + C. 

Step 4: Right-click a blank area in the File Explorer, then select "Paste."  

 

Step 5: Alternatively, you can also press Ctrl + V to paste the copied item. 

Result:  

The program was executed successfully and the output has been verified. 

Output: 

Ctrl +  C  (Copy)  →  Ctrl + V  (Paste)  
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Ex No: 6 Date:   

a) Moving and copying files with mouse 

b) Searching a file or folder by using search command 

c) Recognizing File types using icons 

 

AIM : Moving and copying files with mouse 

Procedure:  

Step 1: Press the Start button + E key.  

Step 2: Select the file or folder. 

Step 3: Right-click the mouse and choose "Copy." 

 

Step 4: Navigate to the new location. 

Step 5: Right-click the mouse and choose "Paste." 

 

  

https://cceindia.in/


COA – Computer on Office Automation - Practical Book 34 

Moving and copying files with mouse Method 2: 

Procedure:  

Step 1: Press the Start button + E key.  

Step 2: To move a file or folder, select it, then left-click and HOLD. (Cut) 

 Step 3: When you release the left mouse button, the file will be moved to the new location 
where you released the mouse button. (Paste)  

Step 4: To copy a file or folder, select it, then right-click and HOLD.  

Step 5: Right-click and choose 'Copy here' to copy the selected item to the new location. 

 

Result:  

The program was executed successfully and the output has been verified. 

Output: 
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AIM : Searching a file or folder by using search command 

Procedure: 

Step 1: Press the Start button + E key.  

Step 2: Select "Search" on a local drive like C:, D:, E:, or This PC to search across all devices 
or folders.  

 

Step 3: In the right corner, Quick Access will show the search box.  

Step 4: Enter the search keyword "COA," then press Enter or click the arrow →. 

 

Output: 
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Aim : Recognizing File types using icons 

Procedure: 

Sort by Arrange Icons 

Step 1: Press the Start button + E key.  

Step 2: Right-click a blank area in File Explorer, then select "Sort by."  

Step 3: Choose an option, such as Name, Date, Size, Type, Date modified, or Dimensions.  

Step 4: The available options vary depending on the selected folder type. 

Ascending: Select to sort items in ascending order (A-Z). 

Descending: Select to sort items in descending order (Z-A). 

 

Group by Arrange icons 

Step 1: Open File Explorer by pressing the Start button + E key. 

Step 2: Right-click a blank area in File Explorer, then select "Group by." 
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Step 3: Alternatively, In the "View" menu, select "Group by" and choose an arrangement 
option like Name, Type, Size, or Date modified. 

Result:  

The program was executed successfully and the output has been verified. 

Output:  

The File Explore, Select Group by Arrange icons by Name, Type, Size or Date modified click 

Arrange Icons. (Start + E  → View →Group by) 
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Ex No: 7 Date:   

a) Recording and saving an audio file 

b) Connecting a printer to the PC 

c) Capturing and saving entire monitor screen & active program window as images 

 

AIM :  Recording and saving an audio file 

Procedure: 

Step 1: Click the Start button.  

Step 2: In the search bar located in the bottom-left corner of the Windows 10 screen, type the 
phrase.  

Step 3: Type 'Voice Recorder.' 

Step 4: Click on 'Voice Recorder.” 

 

Step 5: Press the Ctrl + R keys; recording will start.  

Step 6: Begin speaking.  

Step 7: Press the Backspace key to stop the recording; the file will be saved automatically. 

Result:  

The program was executed successfully and the output has been verified. 
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Output:  

Ctrl + R  →Recording starts 

 

Press the Backspace key - Recording stops 

.  

Recording is saved automatically. 
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AIM : Connecting a printer to the PC 

Procedure: 

Step 1: Click the Start button.  

Step 2: Type in the search bar located in the bottom-left corner of the Windows 10 screen.  

Step 3: Type “Devices and Printers.” 

Step 4: Click on “Printers & Scanners.” 

 

 

Step 5:  Connect Printer to computer and Power ON.  
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Step 6:  Click on Add a printer or Scanner 

Step 7: Wait for it to find nearby printers, then choose the one you want to use, and select 

Add device. 

Result:  

The program was executed successfully and the output has been verified. 

Output:  
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AIM : Capturing and saving entire monitor screen & active program window as images 

Procedure: 

Step 1: The PRINT SCREEN key is usually located in the upper right corner of your keyboard. 
The key looks similar to the following:  

Step 2: The text you see on your keyboard might be PrtSc, PrtScn, or PrntScrn. The other 
text on the Print Screen key is usually SysRq. 

 
Copy only the image of the active window 

The active window is the window you're currently working in. Only one window can be active 
at a time. 

Step 3: Click the window you want to copy.  

Step 4: Press ALT + PRINT SCREEN.  

Step 5: Paste the captured image (CTRL + V) into an Office program or another application. 

Copy the entire image on the screen 

Step 6: Open everything you want to copy and position it the way you want.  

Step 7: Press PRINT SCREEN. (If you're using a laptop, use Fn or Start + PrtSc)  

Step 8: Paste (CTRL + V) the image into an Office program or another application. 

Result: 

The program was executed successfully and the output has been verified. 

Output:  

 

Alt + PrtSc – Copy Active window   
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MS OFFICE: MS-

WORD 

& 

OPEN OFFICE: 

WRITER 
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Ex No:8 Date:  

Preparing a Govt. Order / Official Letter / Business Letter / Circular Letter- Covering formatting 

commands - font size and styles - bold, underline, upper case, lower case, superscript, 

subscript, indenting paragraphs, spacing between lines and characters, tab settings etc. 

 

AIM : Preparing a Govt. Order / Official Letter / Business Letter / Circular Letter- Covering 
formatting commands - font size and styles - bold, underline, upper case, lower case, 
superscript, subscript, indenting paragraphs, spacing between lines and characters, tab 
settings etc. 
 
Procedure: 

Step 1: Press the Start button + R key.  

Step 2: In the box, type "winword" and click OK. 

 

Step 3: Type your letter and apply formatting below.  

Step 4: Press the Ctrl + D shortcut to show font properties.  

Step 5: Change font size and styles: bold, underline, uppercase, lowercase, superscript, 
subscript. 

 

Shortcut  

✓ Font size change: Ctrl + ] (increase), Ctrl + [ (decrease) 
✓ Font Bold: Ctrl + B 
✓ Font Underline: Ctrl + U 
✓ Uppercase: Ctrl + Shift + A 
✓ Capitalize Each Word: Select the text and press SHIFT + F3 
✓ Superscript: Ctrl + Shift + + 
✓ Subscript: Ctrl + = 
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3. To insert a video: 

o Click Insert > Video > Search YouTube or By URL. 
Example: Add a promotional video link from YouTube. 

Step 7: Customize Design 

1. Use the Theme button on the right sidebar to apply a consistent theme. 
Example: Select the Material theme for a professional look. 

2. Customize fonts, colors, and backgrounds for specific slides. 
Example: Change the background to a gradient for the title slide. 

Step 8: Collaborate and Share 

1. Click Share in the top-right corner. 

2. Enter email addresses of collaborators. 
Example: Share with team.marketing@gmail.com and set as Editor. 

3. Add a message like “Please review and add your suggestions by Monday.” 

4. Click Send. 

Step 9: Present Your Slides 

1. Click the Present button in the top-right corner to start the presentation. 
Example: Use the arrow keys to navigate through slides during your presentation. 

Result:  

        The program was executed successfully and the output has been verified. 

Output: 
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In the updated COA examination syllabus, effective after June 2025 

Note: 

1. Preferable Office Packages are: 

a. MS - Office 

b. LibreOffice / OpenOffice / WPS Office 

2. The Weightage for Theory Examinations as follows. 

a. MS WINDOWS and MS OFFICE - 70% 

b. LINUX and OPEN-SOURCE OFFICE PACKAGE - 30% 

3. The Weightage for Practical Examinations as follows. 

a. MS OFFICE / OPEN-SOURCE OFFICE PACKAGE - 50% 

b. E-Office - 50% 

4. e - Learning Resources will be published as a Learning Management System and notified in 

DoTE Website. 

5. QWERTY Keyboard for English and Tamil99 Keyboard Layout for Tamil. 

6. Arial Font for English and Marutham Font for Tamil, with Font Size 12. 

7. Suitable Hardware can be used to practice the exercises prescribed in the syllabus. 

8. Junior Grade Typewriting 30 WPM, Senior Grade Typewriting: 45 WPM.  
Certification is awarded only upon passing the prescribed course. 

இதில் இரண்டு கணினி இயக்க மென்ம ொருள் (Windows & Linux), அலுவலக மெலொண்மெ 

மென்ம ொருள் (MS- Office, opensource office package) & E-Office ெற்றும் இமணயத்தின்  யன் ொடு 

ெற்றும்  யன் டுத்தும் விதம்  ற்றி அறிந்து மகொள்ள உள்ளரீ்கள். மெொத்தம் 7 யூனிட் ஒவ்மவொரு 

யூனிட்டில் இருந்தும் 6 முதல் 8  ெதிப்ம ண்கள் மகள்விகள் மகட்கப் டும். எனமவ நீங்கள் அமனத்து 

யூனிட்கமளயும்  டிக்கமவண்டும்.. 

COA மதர்வொனது Theory, Practical, English Speed, Tamil Speed என நான்கு Exam நமைம றும் 

ஒவ்மவொரு 50 ெதிப்ம ண்க்கு நடத்தபடும் குமறந்த ட்சம் 20 ெதிப்ம ண்களும், அனால் 

குமறந்த ட்சம் ம ாத்தம் 100 ெதிப்ம ண்களும் எடுத்தொல் நீங்கள் மவற்றி ம ற்றதொக கருதப் டும் 
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SCHEME OF VALUATION AND PATTERN OF QUESTION PAPER  

THEORY EXAMINATION 

 

Time: 1 Hr. Max. Marks: 50 Min. Marks to Pass: 20 

Sl. 

No. 
Type of the Questions 

No of 

Questions 

Marks per 

Question 

Total marks for 

this division 

1. Simple Multiple-Choice Questions 10 1 10 

2. 

Multiple Choice Questions with 

two statements of Logical 

Thinking 

10 2 20 

3 Match the Following 10 1 10 

4 True or False 10 1 10 

 Total 50 

 

SCHEME OF VALUATION  

PRACTICAL EXAMINATION 

Time: 1 Hr. Max. Marks: 50 Min. Marks to pass: 20 

Sl. 

No. 
Type of the Questions 

No of 

Questions 

Marks per 

Question 

Total marks for 

this division 

1. 

MS Office / Open-Source Office 

Package Related Question 

Execution 

1 50 50 

2. 
E-office File Submission with the 

output of above stated question 
1 50 50 

Total 50 

Note: 

       Candidate has to perform the exercises as stated in the question in Sl. No. 1 and submit 

the data as Draft Document in E-office application for the question in Sl. No. 2 and also submit 

the data with relevant screenshots (if applicable beyond E-office file submission) in the web 

application portal. 
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PRACTICAL EXERCISES 

OPERATING SYSTEM 

1. Starting a program, running a program Running multiple programs and switching between 
windows Running a program from explorer 

2. Customizing the Taskbar, Making the taskbar wider Controlling the size of start menu options 
Adding a program to the start menu 

3. Recycle bin, restoring the deleted files Arranging icons on the Desktop Creating Shortcuts. 
Adding a program shortcut in the Desktop 

4. Creating and removing folders, renaming folders and files Expanding and collapsing a folder 
Sorting a folder 

5. Displaying the properties for a file or folder Using cut and paste operations to move a file Using 
copy and paste operations to copy a file 

6. Moving and copying files with mouse Searching a file or folder by using search command 
Recognizing File types using icons 

7. Recording and saving an audio file Connecting a printer to the PC Capturing and saving entire 
monitor screen & active program window as images 

MS OFFICE: MS-WORD & OPEN OFFICE: WRITER 

8. Preparing a Govt. Order / Official Letter / Business Letter / Professional Letter / Demi Official 
Letter / Office Memorandum / Office or Legal Proceeding/ Circular - Covering formatting 
commands - font size and styles - bold, underline, upper case, lower case, superscript, 
subscript, indenting paragraphs, spacing between lines and characters, tab settings etc. 

9. Preparing a newsletter: To prepare a newsletter with borders, two columns text, header and 
footer and inserting a graphic image and page layout. 

10. Creating and using styles and templates: To create a style and apply that style in a document 
To create a template for the styles created and assemble the styles for the template. 

11. Creating and editing the table : To create a table using table menu To create a monthly calendar 
using cell editing operations like inserting, joining, deleting, splitting and merging cells To create 
a simple statement for math calculations viz. totaling the column. 

12. Creating numbered lists and bulleted lists: To create numbered lists with different formats 
(with numbers, alphabets, roman letters) To create a bulleted list with different bullet 
characters. 

13. Printing envelopes and mail merge: To print envelopes with from addresses and to addresses 
To use mail merge facility for sending a circular letter to many persons To use mail merge 
facility for printing mailing labels. 

14. Using the special features of word: To find and replace the text, To spell check and correct, To 
generate a table of contents for a document. 

15. Create an advertisement Prepare a resume. Prepare a Corporate Circular letter inviting the 
shareholders to attend the Annual Meeting. 
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MS OFFICE: MS-EXCEL & OPEN OFFICE: CALC 

16. Using formulas and functions: To prepare a Worksheet showing the monthly sales of a 
company in different branch offices (Showing Total Sales, Average Sales). Prepare a 
Statement for preparing Result of 10 students in 5 subjects (using formula to get Distinction, 
I Class, II Class and Fail under Result column against each student). 

17. Operating on the sheets: Finding, deleting and adding records, formatting columns, row 
height, merging, splitting columns etc.,. Connecting the Worksheets and enter the data. 

18. Creating a Chart: To create a chart for comparing the monthly sales of a company in different 
branch offices. 

19. Using the data consolidate command: To use the data consolidate command to calculate the 
total amount budgeted for all departments (wages, travel and entertainment, office supplies 
and so on) or to calculate the average amount budgeted for – say, department office 
expenses. 

20. Sorting Data, Filtering Data and creation of Pivot tables. 

MS OFFICE: MS-POWER POINT & OPEN OFFICE: IMPRESS 

21. Creating a new Presentation based on a template – using Auto content wizard, design 
template and Plain blank presentation. 

22. Creating a Presentation with Slide Transition – Automatic and Manual with different effects. 

23. Creating a Presentation applying Custom Animation effects –Applying multiple effects to the 
same object and changing to a different effect and removing effects. 

24. Creating and Printing handouts. 

E-OFFICE APPLICATIONS 

25. Scanning a document and adding it to the receipts (For Practice only) 

26. Create a File and Put a receipt in the file 

27. Create a Green Note with referencing 

28. Create a Yellow Note with referencing 

29. Create a Draft 

30. Sign and Approve the draft (For Practice only) 

31. Dispatch the approved file and park/close the file (For Practice only) 

DIGITAL COMMUNICATION AND APPLICATIONS 

32. Searching for a website / application / text documents viewing and downloading. 

33. Create an E-mail account, Retrieving messages from inbox, replying, attaching files filtering 
and forwarding 

34. Create a Google form to collect data 

35. Create a Google doc to prepare a document. 

36. Create a Google sheet to collect data. 

37. Create a Google slide to prepare a presentation. 

38. Scan a photo using a scanner and edit it using tools available in the operating system 

by default. 


